Quantifying Phase Configuration Inside an Intact Core Based on Wettability Using X-ray Computed Tomography

Dinara Dussenova
Louisiana State University and Agricultural and Mechanical College

Follow this and additional works at: https://repository.lsu.edu/gradschool_theses

Part of the Petroleum Engineering Commons

Recommended Citation
Dussenova, Dinara, "Quantifying Phase Configuration Inside an Intact Core Based on Wettability Using X-ray Computed Tomography" (2014). LSU Master's Theses. 1462.
https://repository.lsu.edu/gradschool_theses/1462

This Thesis is brought to you for free and open access by the Graduate School at LSU Scholarly Repository. It has been accepted for inclusion in LSU Master's Theses by an authorized graduate school editor of LSU Scholarly Repository. For more information, please contact gradetd@lsu.edu.
QUANTIFYING PHASE CONFIGURATION INSIDE AN INTACT CORE BASED ON WETTABILIT Y USING X-RAY COMPUTED TOMOGRAPHY

A Thesis

Submitted to the Graduate Faculty of the Louisiana State University and Agricultural and Mechanical College in partial fulfillment of the requirements for the degree of Master of Science in Petroleum Engineering.

in

The Craft and Hawkins Department of Petroleum Engineering

by

Dinara Dussenova
B.S., The University of Texas at Austin, 2010
December 2014
Acknowledgements

I am grateful to all the people who have been with me throughout this journey. I would like to thank Dr. Karsten Thompson for giving me an opportunity to complete this work, teaching me and letting me learn. I am highly thankful to Dr. Clinton Willson for support throughout my studies and his patience and guidance. I want to thank Dr. Dandina Rao for graciously agreeing to serve on my exam committee and helping with laboratory space and providing the required equipment.

Special thank you words go to Dr. Kyungmin Ham of Center for Advance Microstructures and Devices at LSU for helping with X-Ray CT and image processing, and Rick Young of department of Geology and Geophysics at LSU for providing a drill bench and vent hood equipment.

I would like to thank the Porous Media research group of Louisiana State University and in particular Godfrey Mills, Timothy Thibodeaux and Paula Sanematsu and many others for their help and constructive feedback. I would also like to thank Paulina Mwangi, Mohamed Al Riyami and Bikash Saikia for letting me use their laboratory and equipment, for their understanding and patience. I am grateful to all of my friends who stood by me through these years and helped me through the work progress. The list includes but not limited to Tomas Rush, Daniel On, Milad Ahmadi, Dillon Massey, Chukwudi Chukwudozie and many others.

I am indebted to the Craft Hawkins Petroleum engineering department, faculty and staff members for creating an opportunity to learn and grow as an engineer, scientist and a researcher.

Lastly I would like to thank my family for the opportunity and strength they have given me. I would not be have been able to do this without them.
Table of Contents

Acknowledgements ................................................................................................................. ii

List of Tables .......................................................................................................................... vi

List of Figures .......................................................................................................................... vii

Abstract ................................................................................................................................. ix

Chapter 1: Introduction .......................................................................................................... 1
  1.1 MOTIVATION ................................................................................................................... 1
  1.2 BACKGROUND .............................................................................................................. 1
  1.3 DESCRIPTION OF CHAPTERS .................................................................................... 3

Chapter 2: Theory and Literature Review ............................................................................. 4
  2.1 MULTIPHASE FLOW ....................................................................................................... 4
    2.1.1 Basics of Multiphase Flow ....................................................................................... 5
    2.1.1.1 Fluid Interaction and Interfacial Tension ............................................................. 5
    2.1.1.2 Wetting and non-wetting phase ........................................................................ 6
    2.1.1.3 Capillary Pressure .............................................................................................. 7
    2.1.1.4 Force Balance on an Oil Droplet ........................................................................ 8
    2.1.1.5 Phase saturations in porous medium .................................................................. 9
    2.1.2 Drainage and Imbibition .......................................................................................... 10
    2.1.2.1 Drainage ........................................................................................................... 10
    2.1.2.2 Imbibition ......................................................................................................... 11
    2.1.3 Capillary Trapping .................................................................................................. 12
      2.1.3.1 Capillary Pressure – Saturation Relationship .................................................... 12
      2.1.3.2 Relative permeability ...................................................................................... 13
      2.1.3.3 Capillary number and mobility ratio ................................................................. 15
  2.2 WETTABILITY .............................................................................................................. 16
    2.2.1 Effect of Wettability on Fluid Distribution ............................................................ 17
      2.2.1.1 Residual phase saturation ................................................................................. 17
    2.2.2 Wettability Alteration ............................................................................................. 19
    2.2.3 Silylation ................................................................................................................ 20
      2.2.3.1 Reaction mechanism ....................................................................................... 20
  2.3 PORE SCALE DATA COLLECTION AND IMAGING ................................................... 22
    2.3.1 X-ray Computer Tomography ............................................................................... 22
    2.3.2 Image Processing and Segmentation .................................................................... 24

Chapter 3: Materials and Experimental Procedure ............................................................ 26
  3.1 MATERIALS AND CHEMICALS ................................................................................. 26
    3.1.1 Brine ....................................................................................................................... 26
    3.1.2 Oil ........................................................................................................................... 27
List of Tables

Table 3.1.1 Brine composition ................................................................. 27
Table 3.1.2 Isopar E properties ............................................................... 27
Table 5.1.1 Summary of the sample description and their notation .............. 60
Table 5.1.2 Segmentation based porosity .................................................. 61
Table 5.2.1 Fluid physical data and core dimensions .................................... 65
Table 5.2.2 \(N_c\) calculations for WWO and OWO ...................................... 65
Table 5.2.3 \(N_c\) calculations for OWW ....................................................... 66
Table 5.2.4 Capillary desaturation based oil saturation estimates ................. 67
Table 5.2.5 Segmentation based \(S_{or}\) estimates ......................................... 68
List of Figures

Figure 1.2.1 Various length scale representation (modified after Armstrong 2012) .................... 2
Figure 2.1.1 Young-laplace equation: relation of the wetting angle to interfacial tensions .......... 6
Figure 2.1.2 Wetting in pores of similar saturations (Abdullah et al. 2007) ............................ 7
Figure 2.1.3 Force balance on a small interface segment ......................................................... 7
Figure 2.1.4 Movement of oil droplet through a pore body (modified after Pope 2003) .......... 9
Figure 2.1.5 Capillary pressure-saturation curves ................................................................. 12
Figure 2.1.6 Relative permeability curves ............................................................................. 14
Figure 2.2.1 (a) Strongly water-wet; (b) Water-wet; (c) Intermediate wet; (d) Oil-wet ........ 18
Figure 2.2.2 Trapped residual wetting and non-wetting phases (Lake 1989) ......................... 19
Figure 2.2.3 Sylaltion reaction and hydrophobic coating formation .................................... 21
Figure 2.3.1 (a) Multilayer monochromator (b) Cone beam microtomography (modified after Wildenschild 2012) .................................................................................. 24
Figure 3.1.1 Oil-brine scan samples ....................................................................................... 28
Figure 3.2.1 Drill press table with a Berea sample ................................................................. 30
Figure 3.2.2 Tomo-core and scaling ....................................................................................... 31
Figure 3.2.3 Tomo-core and the flow cell before and after curing ........................................ 35
Figure 3.2.4 (a) Flow cell leak test (b) Flow cell connectivity test ......................................... 36
Figure 3.3.1 (a) and (b) Schematic of stage 1 of tomo-core flood procedure ....................... 39
Figure 3.3.2 (a) and (b) Schematic of stage 2 of tomo-core flood procedure ....................... 40
Figure 4.2.1 Xradia microCT outside set-up (Biomedical Imaging Division 2014) .............. 43
Figure 4.2.2 Xradia micro CT inside set-up (Biomedical Imaging Division 2014) .............. 43
Figure 4.2.3 MicroCT sinogram (Mathews 2014) ................................................................. 45
Figure 4.3.1 Reconstructed 16 bit grey scale image obtained using cone beam microCT ... 46
Figure 4.3.2 Selection of cropping area ................................................................. 48
Figure 4.3.3 Cropped volume of interest ................................................................. 48
Figure 4.3.4 Histogram for a 16 bit volume of interest ......................................... 49
Figure 4.3.5 Brightness adjustment example ......................................................... 50
Figure 4.3.6 8 bit rescaled REV image ................................................................. 51
Figure 4.3.7 Filtered image example with histogram ............................................. 52
Figure 4.3.8 Filtered vs. unfiltered data comparison ............................................. 53
Figure 4.3.9 (a) Threshold values identification for indicator kriging; (b) indicator kriging segmented image ................................................................. 54
Figure 4.3.10 Original 16 bit image file with phase assigned CT values ............... 57
Figure 4.3.11 Phase rescaled image example ........................................................ 58
Figure 4.3.12 Watershed segmented image example ............................................ 58
Figure 4.3.13 Three phases segmented image example ....................................... 59
Figure 5.1.1 Dry sample segmented for void space ............................................ 62
Figure 5.1.2 WWO segmented for void space ....................................................... 62
Figure 5.1.3 OWO segmented for void space ....................................................... 63
Figure 5.1.4 OWW segmented for void space ....................................................... 63
Figure 5.2.1 Capillary desaturation curves for wetting and non-wetting phases (Lake 1989) .... 67
Figure 5.3.1 Residual oil blob observed in Berea sandstone (Chatzis 1983) ............. 70
Figure 5.3.2 Three-phase segmented WWO orthoviews ..................................... 71
Figure 5.3.3 (a) Oil ganglia reported by Chatzis (1983); (b) Watershed segmented oil ganglia . 71
Figure 5.3.4 Three-phase segmented OWO orthoviews ..................................... 72
Figure 5.3.5 Three-phase segmented OWW orthoviews ..................................... 73
Abstract

The ability to evaluate rock and fluid properties on the order of a few microns opens new areas in reservoir engineering and reservoir simulation. Multiple studies have been done on the application of x-ray computed tomography (microCT) for the pore-scale evaluation of fluid interfaces and rock-fluid interaction. A majority of the fluid flow governing interactions occur at the pore scale level and is usually overseen on large reservoir scales. Hence, it is important to carefully investigate such interactions.

Multi-fluid-phase distribution and interaction of two immiscible fluids such as oil and water is one of the most important and constantly investigated subjects in the oil and gas industry. Oil-water interaction is a complex phenomenon governed by various flow mechanisms in addition to fluid and rock physical properties. Wettability is one of the major concepts of the fluid flow through the porous media and a physical property of the rock that influences hydrocarbon recovery and the recovery methods.

Oil and water phase distribution and residual blob configurations in water-wet and oil-wet Berea sandstone cores were successfully identified using x-ray computed tomography. Residual and remaining oil saturations were calculated from the obtained images. Rock porosity was calculated using indicator kriging segmentation technique and fluid saturations were calculated using watershed segmentation. Residual oil blob geometry in the water-wet core was successfully obtained from the segmented images. Oil saturations and phase configurations were in agreement with the oil saturation estimations obtained through the capillary desaturation analysis.
Chapter 1: Introduction

1.1 MOTIVATION

The study of the porous media physical properties has drastically changed in the past several decades with the improvement in imaging tools, computer evolution and imaging software. X-ray computed tomography (hereinafter: microCT) tools and analyzing software have undergone significant changes, which allow attaining rock and fluid properties as low as 1 nanometer in dimensions and obtaining clear and detailed images. Moreover, improvements in reconstruction tools and visualization software have led to the development of detailed and more accurate porous media models. Therefore, the objective of this research was (1) to evaluate equilibrium hydrocarbon-water pore-scale distribution under different wettability conditions and displacement mechanisms; (2) to test available porous media visualization and segmentation tools on multi-fluid-phase (hereinafter: multiphase) saturated Berea sandstone; and (3) to design micro scale core flood techniques and core flood procedures.

1.2 BACKGROUND

All hydrocarbon reservoirs are saturated with two or more phases, with a majority of liquid hydrocarbon reservoirs containing water, liquid hydrocarbon and/or gas. Fluid flow through porous media is a complex phenomenon which is governed by various phenomena and processes that primarily exist between the immiscible fluids such as hydrocarbon and water. Hence, understanding and proper evaluation of multiphase fluid distribution and transport mechanisms at the pore scale is important to many fundamental processes in petroleum engineering.

There are different length scales for different physical and chemical reservoir properties. Typically, the length scale ranges from pore scale to a reservoir scale. Reservoir engineering
operations and simulations are performed on a large length scale – reservoir scale, where physical porous medium parameters are averaged over an elementary volume. Pore scale gives information on each grain that is visible at a given resolution along with spatial information of a visually identified pore structure, the immiscible fluid distribution and the interfaces between them. Figure 1.2.1 shows various length scales and major physical parameters identified at each level (Muskat 1949, Walsh and Lake 2003, Armstrong 2012).

Figure 1.2.1 Various length scale representation (modified after Armstrong 2012)

X-ray computed tomography is a non-destructive tool that allows detailed examination of multiphase fluid distribution and reservoir physical properties on a micro scale. Recent studies by Armstrong et al. (2012), Iglauer et al. (2012) and Wildenschild et al. (2012) showed the methodology of extracting capillary pressure values, fluid phase curvatures, and distributions from CT images. Moreover, there are known attempts of estimating surface areas and possibly contact angles using microCT (Culligan et al. 2004, Armstrong 2012, Wildenschild et al 2012). Large scale transport phenomena and design of appropriate recovering techniques requires proper understanding of flow process and fluid communication on a pore scale. The focus of this research was on the evaluation of oil-water distribution in typical Berea sandstone on a micrometer level.
1.3 DESCRIPTION OF CHAPTERS

The theory and literature review is given in Chapter 2. Chapter 3 describes the core flood procedure. Chapter 4 discusses imaging procedure, visualization and segmentation techniques. Chapter 5 discusses porous media properties estimation and qualitative oil-water distribution and phase residual saturation estimation analysis. It also details the difference in fluid distributions in differently wet cores. The conclusions, summary and future recommendations are then given in Chapter 6.
Chapter 2: Theory and Literature Review

Porous media studies using microCT have improved drastically in the last decade both in terms of efficiency, precision, and accuracy. Advanced microCT tools and high computational power are more readily available for detailed investigation in sand packs, glass beads and intact cores. With the ever-growing interest, tools and software efficiency several research areas within reservoir engineering have broadened and valuable results reported. This section covers the theory on the microCT application in porous media, wettability alteration through sylilation and basics of multiphase flow and multi fluid distribution in porous media. This will create a theoretical background for the main thesis. A more detailed and specific pertinent description of the applied theory and used software tools and instruments will be discussed in relevant sections.

2.1 MULTIPHASE FLOW

Production from a hydrocarbon reservoir, mainly oil reservoirs, involves production of oil at the residual water saturation. However, as a reservoir depletes and in-situ pressure decreases the flow becomes two or three phase flow, also known as multiphase flow (Pope 2003). The presence of several immiscible fluids in a pore of a reservoir rock results in an interface between each immiscible phase (Dullien 1979). Such interfaces between immiscible fluids result in capillary pressure. When water is injected to displace oil in a porous medium, capillary force prevents oil from being displaced completely, which results in residual oil saturation, $S_{or}$ (Pope 2003). Therefore, immiscible fluid interfaces resulting in capillary pressure are closely related to cumulative oil recovery. Oil recovery is one of the most important aspects of petroleum engineering, it is important to understand fundamentals of multiphase flow and multi fluid
distribution in porous medium. This section will touch basis on multiphase flow theory, fluid distribution and behavior within the reservoir rock.

2.1.1 Basics of Multiphase Flow

Ultimate goal of reservoir engineering is to spatially quantify pressures and phase saturations at a given time step. A number of numerical models exist that relate constitutive relationships and flow equations to the mass conservation for each of the fluid phases. Physical laws describing force distribution such constitutive relationships for the contact angle, the interfacial tension and the capillary pressure are further explained.

2.1.1.1 Fluid Interaction and Interfacial Tension

During the immiscible multiphase flow in a porous medium, a phase boundary or fluid interface is created. This interface governs most of the major fluid flow mechanisms in the porous medium. Additionally, alongside the phase boundary both fluids’ intensive properties change discontinuously (Lake 1989). In oil-water saturated porous medium three interfaces are created: (1) oil-water interface, (2) oil-solid interface, and (3) water-solid interface. Along each interface a force, interfacial tension is observed. Interfacial tension is tangential to the phase surface boundary and is measured in force per unit length and usually noted as \( \sigma \). Thus, in a two phase saturated porous medium three interfacial tensions are identified. Angle \( \theta \) is formed between oil-water interfacial tension and water-solid surface tension and is called a wetting angle. The relationship between wetting angle and interfacial/surface tensions in an oil-water saturated core is described in Young-Laplace equation (2.1). A detailed sketch of Young-Laplace equations is represented in Figure 2.1.1 (Lake 1989).

\[
\sigma_{wo} \cos \theta = \sigma_{so} - \sigma_{sw} \quad \ldots \ldots \ldots \quad (2.1)
\]
Figure 2.1.1 Young-laplace equation: relation of the wetting angle to interfacial tensions

Where:

\( \sigma_{wo} \) – interfacial tension between oil-water;

\( \sigma_{so} \) – interfacial tension between oil-solid;

\( \sigma_{sw} \) – interfacial tension between water-solid;

\( \theta \) – wetting angle (Lake 1989).

2.1.1.2 Wetting and non-wetting phase

In a two phase immiscible system, the fluid phase that is affine to the rock surface and primarily covers it is called a wetting phase. The other fluid phase is called a non-wetting phase. In the petroleum industry reservoir rocks are either categorized as water-wet, oil wet or intermediate wet (Craig 1971). According to Craig (1971), in water-wet rocks the wetting phase, water, is in favor of the rock surface. In oil-wet rocks oil is in favor of the rock surface. In intermediate wet rocks, the rock surface observes both water-wet and oil-wet characteristics and contains certain pores that are either preferable to water or oil. As wetting fluids are affine to the rock, they are most likely to occupy smaller pores and rock surfaces, thus influencing a flow path during the flow (Salathiel 1973). Figure 2.1.2 illustrates wetting and non-wetting fluids distribution in a porous medium at similar saturations.
2.1.3 Capillary Pressure

Pressure is a force per unit area. In order to properly understand fluid-fluid interaction in a porous medium, consider a small segment, where force balance can be examined (Figure 2.1.3). Fluid-fluid interaction is represented by a simple surface curvature. $P_{nw}$ stands for a pressure in a non-wetting phase and $P_w$ stands for a pressure in a wetting phase.

Capillary pressure relates interfacial tension between two fluids to the interface curvature, which makes it one of the most important and fundamental characteristics of the porous medium.
along with such physical properties as porosity, permeability, and pore geometry. Equation 2.2 gives Young-Laplace equation for a simply shaped porous geometry.

The interface curvature has a curvature radius of $R$, the interfacial tension between two fluids is $\sigma$, after solving the force balance at static equilibrium, Young-Laplace equation is modified, and capillary pressure, $P_c$, is expressed as the following (equation 2.2):

$$P_c = P_{nw} - P_w = \frac{2\sigma}{R} \quad \ldots \quad (2.2)$$

In reality a pore space is more complex. Hence, fluid-fluid curvatures are of various geometrical and spatial orientations (Lake 1989). In such case curvature radius is replaced with a mean curvature or curvature tensor, and the wetting angle, $\theta$, is accounted in the force balance.

**2.1.1.4 Force Balance on an Oil Droplet**

Typical porous medium has a complex geometry. In a multiphase system, when an oil droplet travels through a single pore, it needs to overcome the capillary pressure created between fluid interfaces in a pore throat. A pore throat has a smaller radius than the pore body. Thus, as the capillary pressure is inversely proportional to the radius of the curvature, it requires higher pressure gradient for the oil droplet to travel through the pore throat than for the droplet to travel through the pore body (Pope 2003, Armstrong 2012). Figure 2.1.4 shows a simplified sketch of a single pore and an oil droplet in a water-wet rock surface. In the system shown in Figure 2.1.4, pore has a radius, $r_p$, and the wetting angle is greater than 0. After performing the force balance on the given system, the capillary pressure for an oil droplet in a single pore is derived as shown in equation 2.4.
Figure 2.1.4 Movement of oil droplet through a pore body (modified after Pope 2003)

\[ P_c = P_o - P_w = \frac{2\sigma \cos \theta}{r_p} \]  \hspace{1cm} 2.4

Analyzing equation 2.4 one can see that if pressure in the water phase, \( P_w \), is high enough, the pressure gradient created by the water phase will exceed capillary pressure, and, thus, move the oil droplet through the pore. Nonetheless, if pressure in water phase is not enough to exceed capillary pressure then the oil droplet is captured. Captured oil droplets result in residual oil saturation (Lake 1989). Condition for an oil droplet movement through a single pore is shown in equation 2.5.

\[ L_o \frac{\partial P_w}{\partial x} \geq \frac{2\sigma \cos \theta}{r_p} \]  \hspace{1cm} 2.5

Where:

\( L_o \) – length of the pore;

\( \partial P_w \) – pressure in the water phase;

2.1.5 Phase saturations in porous medium

A porous medium can be saturated with two or more phases: liquids and/or gases. Phase saturation, usually abbreviated as \( S_p \), where \( p \) is a subscript for a specific phase and is defined as a fraction of a pore space occupied by a particular phase, e.g.: water saturation is \( S_w \) and oil saturation is \( S_o \) (Welch and Lake 2003).
Since movement of one phase through a single pore that contains multiple fluids depends on the capillary pressure and pressure gradient in each phase separately, capillary pressure is typically considered to be function of saturation (equation 2.6).

\[ P_{nw} - P_w = P_c(S_w) \]  

\text{2.1.2 Drainage and Imbibition}

A hydrocarbon reservoir normally contains petroleum fluids and reservoir brine - an aqueous phase. In the case where the reservoir is water-wet – reservoir brine is the wetting phase, and in the case where the reservoir is oil-wet – petroleum fluids are the wetting phase. Depending on the rock wettability two displacement mechanisms are observed: drainage and imbibition.

\textit{2.1.2.1 Drainage}

Hydrocarbons travel from the source rock to the reservoir rock by displacing brine in the reservoir rock. If the reservoir rock is water-wet, then such process is called drainage. Hence, drainage is a displacement of a wetting phase by a non-wetting phase (Welsh and Lake 2003, Al-Raoush et al., 2004). Hydrocarbon migration from a source rock into a reservoir rock is called primary drainage. As primary drainage occurs, capillary pressure increases until it reaches its critical point at which further displacement is impossible. In this case, the wetting phase is at its irreducible saturation or in case of oil reservoirs — connate saturation. During drainage, wetting fluid displacement is controlled by Haines jumps. Haines jump is rapid movement of interfaces through a pore throat. At the end of the process most pores are filled with a non-wetting phase, and a wetting phase is spread out as a film on the rock surface (Jerauld and Salter, 1990).
2.1.2.2 Imbibition

Imbibition is another displacement mechanism that is highly important in understanding multiphase flow in porous media. Originally, a majority of sandstone reservoirs are water-wet and saturated with connate or irreducible water and hydrocarbons. During hydrocarbon production, reservoir pressure depletes and hydrocarbons are replaced by water either from surrounding aquifers or through water injection also known as waterflooding. Such process of water invasion is called imbibition. Therefore, imbibition is defined as a displacement of a non-wetting phase by a wetting phase. During imbibition, capillary pressure decreases until it reaches close to “0” value, at which non-wetting phase is no longer movable and at its residual saturation (Welsh and Lake 2003, Al-Raoush 2006).

Imbibition is controlled by two flowing scenarios: choke-off and retraction displacement. During choke-off, the wetting phase flow migration is controlled by the flow of the wetting phase film on the rock surface. Choke-off is highly dependent on the aspect ratio of the system: ratio of pore-body size to pore-throat size. As the aspect ratio of the system increases, choke-off flow becomes a controlling scenario of imbibition displacement. During retraction displacement, the wetting phase moves through the porous medium as a large blob simulating a piston-like displacement (Li and Wardlaw 1986; Mohanty et al. 1987; Jerald and Salter, 1990).

Both displacements, drainage and imbibition, are functions of capillary pressure and phases’ initial saturation. The amount of fluid phase trapped at the end of each process depends on rock and fluid physical properties such as porosity, permeability, fluid density and interfacial tension. Therefore, it is critical to understand fluid trapping and capillary pressure-saturation behavior during each process.
2.1.3 Capillary Trapping

Capillary pressure is a governing condition for fluid phase migration through a porous medium. Capillary pressure regularly is expressed as a constitutive function of saturation. Depending on rock wettability, initial conditions and physical characteristics of the reservoir rock, fluids can either be displaced by drainage or imbibition. Traditional water-wet hydrocarbon reservoir first goes through primary drainage as a process of hydrocarbon accumulation and then through imbibition during hydrocarbon recovery (see section 2.1.2 for more details). Figure 2.1.5 shows graphical representation of such constitutive relationship between capillary pressure and saturation.

![Figure 2.1.5 Capillary pressure-saturation curves](image)

2.1.3.1 Capillary Pressure – Saturation Relationship

The dashed line on Figure 2.1.5 represents the primary drainage curve and the solid line represents the imbibition curve. As wetting phase is displaced, capillary pressure increases until a critical point, at which the wetting phase exists at irreducible saturation. Capillary pressure is inversely proportional to the radius of the pore throat or radius of the interface curvature.
Therefore, drainage is mainly controlled by the smallest pore throats. Whereas, during imbibition process, capillary pressure decreases as the non-wetting phase is displaced. Thus, imbibition is mostly controlled by the largest pore throats. The imbibition process can be initiated anywhere on the drainage curve and drainage can be initiated anywhere on the imbibition curve, which depicted by dashed red lines on Figure 2.1.5 modeling. Two processes are dependent on each other based on the history of the previous events. Such behavior is called hysteretic and curves are called hysteresis in relation to one another. Dependence of current behavior on the history of the previous results generally complicates any type of reservoir modeling (Lake 1984, Al-Raoush 2006, Armstrong 2012).

\[ P_d \] on Figure 2.1.6 stands for the non-wetting fluid entry pressure and represents the capillary pressure required to initiate displacement during drainage. Fluid entry pressure is a function of the largest pore throat size. As both drainage and imbibition are dependent on pore throat size, thus, \( P_c-S \) curves provide information on the effect of porous medium’s pore throat size distribution on fluid flow and phase capillary trapping (Lake 1984, Al-Raoush 2006, Armstrong 2012).

### 2.1.3.2 Relative permeability

Production from hydrocarbon reservoirs results in a multiphase flow. Initially hydrocarbons flow under irreducible water saturation. However, as reservoir depletes and the reservoir pressure decreases, the flow becomes two-phase (oil-water) or three-phase (oil-water-gas) in case of solution gas drive. Water displaces oil during primary hydrocarbon production as an influx from the aquifer or by means of water injection during the waterflooding. Currently, waterflooding is one of the most applied methods of secondary recovery in oil reservoirs (Lake 1989, Walsh and Lake. 2003, Pope 2003). Permeability, \( k \), of the medium also referred to as
absolute permeability is ability of the rock medium to transport fluids. During the immiscible multiphase flow, the permeability of a specific phase is less than the permeability of the total porous medium and is usually referred to as a phase permeability; e.g., $k_o$ or $k_w$. The permeability of each phase depends on its saturation. The relationship between phase permeability and absolute permeability is called relative permeability, $k_r$. Figure 2.1.6 shows the sketch of relative permeability curves for water-oil system. On Figure 2.1.6, the single dot dashed line represents oil relative permeability and a double dot dashed line is water relative permeability. Relative permeability curve starts with 0 value and rises until its end point values.

![Figure 2.1.6 Relative permeability curves](image)

There are two acceptable ways to define relative permeability; e.g., oil relative permeability, $k_{ro}$, can be defined as:
1. oil permeability divided by rock absolute permeability; where rock absolute permeability is a permeability of the medium at either (a) 100% air saturation or (b) 100% water saturation;

2. oil permeability divided by oil permeability at irreducible water saturation.

Equations 2.7 and 2.8 show relative permeability expressions for both definitions (Muskat 1949).

$$k_{ro} = \frac{k_o}{k_{abs}} \quad \ldots \ldots \text{2.7}$$

$$k_{ro} = \frac{k_o}{k_o \text{ at } (S_{ir})} \quad \ldots \ldots \text{2.8}$$

### 2.1.3.3 Capillary number and mobility ratio

As shown in the previous section, in a multiphase system fluids flow through porous medium at different fractions. The amount of fluid flowing through a porous medium is dependent on its relative permeability, absolute permeability of the porous medium and fluid viscosity. The relationship between the three is called fluid mobility, $\lambda$, which is expressed as shown in equation 2.9.

$$\lambda_j = \frac{kk_{rj}}{\mu_j} \quad \ldots \ldots \text{2.9}$$

Where index “$j$” stands for phase index e.g.: “$w$” for water or “$o$” for oil (Lake 1989, Pope 2003, Armstrong 2012).

In a multiphase system viscous and capillary forces are fundamental instances. Trapping of a non-wetting phase in a porous media is governed by competition between viscous and the capillary forces. Viscous forces are the forces that mobilize the non-wetting phase and the capillary forces are responsible for trapping of the non-wetting phase (Lake 1989). The best way
to relate two instances is the capillary number, $N_c$, which is the ratio of viscous forces to capillary forces and defined as the following:

$$N_c = \frac{u \mu}{\sigma} \ldots \ldots 2.9$$

Where, $u$ is fluid velocity, $\mu$ is fluid viscosity, and $\sigma$ is interfacial tension.

Capillary number is inversely proportional to oil saturation. For example, in a water-wet oil reservoir as capillary number increases, oil saturation decreases. Once capillary number goes over its critical value, oil saturation may decrease to as low as 1%. Capillary number-oil saturation relationship depends on pore morphology, oil properties and rock wettability. Such curves are called capillary desaturation curves and are widely used in petroleum industry (Lake 1984).

**2.2 WETTABILTY**

Wettability is one of the most important factors of hydrocarbon production that controls fluid-fluid interactions and displacement mechanisms in the rock. In petroleum industry, reservoir rocks are either categorized as water-wet, oil-wet and intermediate wet. (Craig 1971). Originally all quartz based sandstones are strongly water-wet. However, due to exposure to oil components under high temperature and pressure such sandstones can turn oil-wet. Continuous deposition of oil products such as polar crude oil compounds containing nitrogen, oxygen or sulphur can create hydrocarbon coating on the rock surface and alter its chemical structure. As a result, a majority of the oil reservoirs nowadays exhibit intermediate wettability. Carbonate reservoirs, on the other hand, are prone to be hydrophobic or in favor of non-aqueous phase (Craig 1971, Takashi 2009, Chandrasekhar 2013).
2.2.1 Effect of Wettability on Fluid Distribution

In water-wet hydrocarbon reservoirs, water is affine to the rock surface and, hence, occupies smaller pores, while oil is found in the bigger pores or in the center of the pore. In oil-wet reservoirs, fluid distribution is opposite of the one in water-wet rock. As the wetting phase is in favor of the rock surface and the non-wetting phase is tangential to the wetting phase, contact angle between two phases is used to differentiate wettability states based on fluid distribution. Figure 2.2.1 (a) through (d) shows rock wettability characterization based on contact angle. Rock surface is considered water wet if contact angle, \( \theta \), is less than 90\(^\circ\), and is oil-wet when contact angle is greater than 90\(^\circ\). If \( \theta \) is equal to 90\(^\circ\) reservoir is considered intermediate wet. The definition and contact angle values are derived solving force balance in Young-Laplace equation (equation 2.1) (Takashi 2009, Sharma 2011, Armstrong 2012, Chandrasekhar 2013). Previously cited Figure 2.1.2 is a good example of the fluid phase distribution in a pore space of different wettability rocks.

2.2.1.1 Residual phase saturation

Fluid distribution varies with the pore space based on the rock wettability including many other factors (Figure 2.1.2). Residual phase distribution for the wetting and the non-wetting phases differs as well. The amount of fluid left behind the displacing front depends on the rock wettability, type of displacement mechanism and the mobility ratio. During the drainage displacement, the pressure gradient increases forcing the wetting phase into the curved parts of the pore space. Thus, assuming the pore has a rhomboidal shape, then the wetting phase occupies the surface and the angles of the rhomb. The non-wetting phase is not attracted by the surface of the rock and theoretically can be displaced completely. Such theoretical scenario is only possible at extremely high capillary pressures or when the interfacial tension values between two
immiscible phases is low. Either one of these cases is hard to achieve in the natural reservoir rocks. Therefore, non-wetting phase saturation after the imbition flow tends to be close to residual wetting phase saturation, $S_r$ (Lake 1989). Figure 2.2.2 shows wetting and non-wetting phase saturations distribution.

![Diagram of wetting and non-wetting phase saturations](image)

Figure 2.2.1 (a) Strongly water-wet; (b) Water-wet; (c) Intermediate wet; (d) Oil-wet

Morrow (1990) and many others (Raza et al. 1968, Owens and Archer 1971, Donaldson and Thomas 1971) have shown in their in work that during the recovery of oil by waterfloodning, oil recovery decreases as the wettability goes from water-wet to oil-wet. The efficiency of the oil displacement during the water flood in water-wet rock can be explained by the high capillary drive during the imbition and rock’s preference to water. Oil displacing efficiency also depends on fluids’ viscosities and mobility ratio. Morrow (1990) observed that it is possible to reach low residual oil saturation in intermediate wet conditions. In intermediate wet reservoirs, oil is displaced from the large pores and almost no oil will be trapped in small pores or at the rock surface.
2.2.2 Wettability Alteration

Extensive work has been done on altering the wettability of the carbonate reservoirs from oil-wet to water-wet in order to increase oil recovery. Current research on oil production from sandstone reservoirs reveals improved oil recovery when wettability in sandstones is altered from water wet to intermediate wet. Wettability alteration in sandstones is achieved through low salinity brine floods, surfactant flooding, aging rocks in oil under high temperature and pressure or chemical treatment of the rock surfaces leading to the creation of the hydrophobic coating on the rock surface (Paidin 2006, Sharma 2011, and Chandrasekhar 2013). Chemical treatment of the quartz surfaces through silylation reaction has been widely studied through a set of laboratory experiments on glass beads and quartz plates.

Figure 2.2.2 Trapped residual wetting and non-wetting phases (Lake 1989)
2.2.3 Silylation

Silylation reaction is achieved through reaction of organosilanes with the hydrogen atom in hydroxyle group. During a silylation reaction, the hydroxyle group is replaced by organosilyl group, which turns inorganic surfaces from hydrophilic to hydrophobic. One of the most widely used groups of organosilanes is methylsilanes. This section will be focused on methylsilanes reaction mechanisms, in particular, dimethyldichlorosilane, in order to create a hydrophobic coating on the quartz surfaces (Arkles and Gelest Group 2006, Paidin 2006).

2.2.3.1 Reaction mechanism

Organosilanes have general formula of $R_nSiX(4-n)$. The $R$ group usually consists of hydrophobic alkyl chain and the $X$ group consists of hydrophilic halogen, alkoxy, acyloxy or amine. Group $R$ is responsible for providing quartz surfaces with the desired hydrophobic properties. As alkyl chain represented by $R$ might contain a variety of functional groups; hence, it is possible for organosilanes to react with number of surfaces of complex chemical and physical structures. Water is required for organosilanes to form hydrophobic coating on the surface. Such water can either be an adsorped water, added water to the reaction or in certain cases in a form of atmospheric water moisture (Arkles 1977).

The first stage of the reaction is the formation of silanol containing compounds through the hydrolysis of the $X$ group. Subsequently, these silanol compounds condense into a water phase and form siloxane-linked oligomers. Oligomers further hydrogen bond to the hydroxyl group of the surface silanols condensed in water. Typically, high temperature curing or drying is required for the final step of the coating formation. During the drying process, water is evaporated and hydrogen bonding is substituted with covalent bonding. Methoxysilanes are the type of organosilanes that do not require high temperature curing as they are capable of reacting
in dry conditions due to their reactivity. At the moment silanes with three hydrolysable groups are used for the surface treatment. As the result of the crosslinking such silanes produce a three dimensional multilayer coating on the surface. Such three dimensional multipliers create more stable coating than the monolayer. However, in either case surfaces obtain the same hydrophobic properties (Moral 1986, Arkles and Gelest Group 2006, Paidin 2006). Figure 2.2.3 shows step by step chemical reactions during the silane deposition.

Figure 2.2.3 Sylaltion reaction and hydrophobic coating formation
2.3 PORE SCALE DATA COLLECTION AND IMAGING

Pore scale data interpretation such as pore morphology, pore capillarity, and imbibition and drainage curves can be reproduced using various techniques. Data extracted from the Brunauer-Emmett-Teller (BET) test, mercury intrusion test, stereo microscopy and x-ray computed tomography can provide such information as pore size distribution, porosity, permeability, mineralogy, and capillary pressure-saturation curves. However, not all of them are comparable in data quality and testing techniques. BET and mercury intrusion tests require sample drying and grinding, so the testing conditions are not the same as the in-situ reservoir conditions. Stereo microscopy and x-ray computed tomography are two non-destructive techniques. Stereo microscopy provides two-dimensional images and x-ray computed tomography provides three-dimensional images. This work is focused on using x-ray computed tomography data to qualitatively identify and quantify immiscible fluid distribution at the pore scale. In the following sections x-ray computed tomography or microCT and the image processing and interpretation techniques will be discussed.

2.3.1 X-ray Computer Tomography

X-ray computed tomography is a non-destructive and a non-invasive tool that can reproduce pore scale data in three dimensions at voxel resolutions as low as few microns (Culligan et al. 2006, Karpyn et al. 2010, and Armstrong 2012, Wildenschild et al. 2012,). Three-dimensional images are obtained by mapping x-ray attenuation coefficients through the sample interior. A voxel is a three-dimensional unit such as pixel in two dimensions that contains information (i.e. the x-ray attenuation coefficient) for each discrete element. MicroCT scanning is performed by capturing x-ray projections at various angles from 0 to 180 degrees. Initially
sinusoidal two-dimensional images are collected, which later reconstructed to form three-dimensional grey scale volume images.

Element differentiation on the image is based on the fluid density and chemical composition and rock density and mineralogy. Attenuation coefficients, image basic components, depend on the atomic mass of the component. X-ray absorption increases as atomic mass of the compound increases. Beers’ law (equation 2.10) relates material thickness and tabulated attenuation coefficient to the x-ray absorption for a given material.

\[ I = I_0 e^{-\mu x} \] \hspace{1cm} 2.10

Where, \( I \) is x-ray attenuation intensity per unit length, \( I_0 \) is incident radiation intensity, \( x \) is a thickness of the material and \( \mu \) is a linear attenuation coefficient (Culligan et al. 2004, Al-Raoush 2006, Wildenschild et al. 2012).

For multiphase systems such as oil, water and rock grains a tracer such as iodine or cesium containing compounds may be required. Often the tracer is added into a water phase to enhance contrast between two immiscible fluids and determine phase interfaces.

There are various microCT set-ups and equipment available at the moment. Multilayer monochromator microtomography and cone beam microtomography were used throughout this project at various experiment stages. Multiplayer monochromator microtomography allows scanning at different wave length, and thus, at different monochromatic energy levels. Such system lets scanning above and below photoelectric edges of the tracer, which can provide a more visible contrast between immiscible fluids. Figure 2.3.1 represents typical tomography set-up for multilayer monochromator and cone beam microtomography (Culligan 2004, Al-Raoush 2006, Karpyn 2010, Armstrong 2012, Wildenschild 2012).
2.3.2 Image Processing and Segmentation

In order to extract qualitative or quantitative data from the x-ray computed tomography images, several steps of image processing and handling must be performed. This includes enhancement of the phase separation by edge energy or discrete compound intensity. Before an image is segmented for multiple phases, image scaling for contrast enhancement and image smoothing for noise removal are performed.

Image scaling is usually performed on 16 bit reconstructed images that contain information from 0 to $2^{16}$ or 65536 intensity counts. Original scaling is done for the phase of interest so that unwanted information is not visible on the image. Such approach helps to identify phase, rock and void space boundaries. Once image scaling is performed and image sequence is
converted from 16 bit to 8 bit, the image is filtered in order to smooth noise by suppressing high frequency data values (Al-Raoush 2006). Anisotropic diffusion method was used in this work to remove noise.

There are different segmentation methods available at the moment. Indicator kriging and gradient based watershed segmentation are examined and used for image segmentation in this work.

Indicator kriging is based on upper and lower thresholding of the voxel intensity values. User identifies upper and lower threshold boundaries so that all voxels that have intensity values above the upper threshold are assigned to one phase and all below the lower threshold are assigned to the other phase. Voxel intensity values in between upper and lower threshold values are assigned by local kriging correlation function (Oh and Lindquist 1999).

Watershed segmentation is another segmentation method used in this work. Watershed segmentation uses simple thresholds for known regions and image intensity gradient for transition regions such as between two immiscible fluids. Hence, watershed segmentation is recommended for immiscible liquid phase segmentation (Armstrong 2012).
Chapter 3: Materials and Experimental Procedure

In order to perform phase separation on the pore scale image, specific sample preparation was required prior x-ray computer tomography. One of the biggest challenges was creating and identifying the right parameters for core size, flow cell material, and mechanisms of fluid injection. This chapter introduces description of materials, chemicals and reagents used for the experimental preparation. It also covers steps for obtaining the cores used in tomography, the procedure for modifying wettability, and detailed descriptions of flow cell preparation and core flooding.

3.1 MATERIALS AND CHEMICALS

Chemicals and saturating fluids used in this experiment includes injected brine, oil, tomography tracers, and wettability altering reagents. This section will give a detailed description of brine composition and properties of oil and wettability altering agent.

3.1.1 Brine

The purpose of the experiment was to create a multiphase system within an intact Berea sandstone core. Deionized water was chosen as a base for the aqueous phase. Berea sandstones on average contain 6%-8% of clay minerals (Churcher et al. 1991). Therefore, in order to prevent clay swelling and fines migration during the brine injection, 50,000 ppm of sodium chloride was added to the deionized water.

Water, oil and air have low attenuation coefficients. Hence, if scanned without tracers, it is hard to identify the phases based on the intensity values. In order to enhance phase separation between oil and brine on the image, 50,000 ppm of potassium iodine was added into the brine. Both potassium iodine and sodium chloride were specified to have 99.3%-99.9% activity and
were obtained from Fisher Scientific. Table 3.1.1 shows the injected brine composition used in
the fluid injection experiments.

Table 3.1.1 Brine composition

<table>
<thead>
<tr>
<th>Ion</th>
<th>Ion Concentration (ppm)</th>
<th>Chemical Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Na+</td>
<td>50,000</td>
<td>NaCl</td>
</tr>
<tr>
<td>K+</td>
<td>50,000</td>
<td>KI</td>
</tr>
</tbody>
</table>

3.1.2 Oil

Isopar E manufactured by ExxonMobil Chemical was chosen as the hydrocarbon phase. Isopar E consists of C7-C10 isoalkanes with viscosity of 0.62 cp, density of 0.73 g/cc at 15.6 °C and interfacial tension of 21dynes/cm. Material data sheet reports that Isopar E is of low toxicity; however, because it may release flammable vapors it should be handled in places with good ventilation. The product is insoluble in water and slightly volatile. A set of oil-brine experiments was performed at 10%, 30%, 50%, 70% and 90% of Isopar E in brine in order confirm insolubility of the product in water and observe possible emulsion formation. Based on the scan of oil in water the mixture of water, potassium iodide and sodium chloride with oil was proven to be insoluble in water and no emulsion in the given brine formulation was detected. Clear phase separation was observed in all the mixtures. Table 3.1.2 summarizes the Isopar E physical properties and Figure 3.1.1 represents oil-water scan samples (ExxonMobil Chemical Isopar E Material Security Data Sheet). On Figure 3.1.1 the dashed red lines depicts phase separation between Isopar E and brine.

Table 3.1.2 Isopar E properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\gamma$</td>
<td>0.724</td>
</tr>
<tr>
<td>$\rho$</td>
<td>g/cc @15.6C</td>
</tr>
<tr>
<td>$\mu$</td>
<td>cp</td>
</tr>
<tr>
<td>$\sigma$</td>
<td>N/m</td>
</tr>
<tr>
<td></td>
<td>0.731</td>
</tr>
<tr>
<td></td>
<td>0.62</td>
</tr>
<tr>
<td></td>
<td>0.0210</td>
</tr>
</tbody>
</table>
Dimethyldichlorosilane and Reagents

Dimethyldichlorosilane (DMDCS) is an organosilane with a chemical formula of Si(CH$_3$)$_2$Cl$_2$. As described in Chapter 2, dimethyldichlorosilane is a compound that turns hydrophilic surfaces more hydrophobic by forming hydrophobic coating on inorganic surface. According to NOAA DMDCS is highly flammable and corrosive. It is colorless liquid that fumes in the air. Dimethyldichlorosilane reacts violently with water or moist air and generates gaseous hydrogen chloride (HCl); therefore, high caution should be practiced. In DMDCS silicon is bonded to either one or four chlorine atoms and with the other bond to either hydrogen or alkyle group. Dimethyldichlorosilane is a highly reactive compound with volatile byproducts, which gives it an advantage when compared to other organosilanes (NOAA.gov 2014). DMDCS used in these experiments was obtained through Fisher Scientific in a 100ml bottle manufactured by Acros Organics. The compound was 99.9% active.

Wettability altering agents such as dimethyldichlorosilane are usually mixed with alkanes such as Methylene Chloride (CH$_2$Cl$_2$) in the ratio of 5%-10% of DMDCS to 95%-90% (CH$_2$Cl$_2$). Additionally, alcohols such as Methanol (CH$_3$OH) are used for intermediate cleaning and deactivating steps as DMDCS is a highly reactive substance (Almanza-Workman 2001). All of the listed coupling agents are 99.9% active.
3.2 CORE PREPARATION

Core dimensions are critical for the microCT because image resolution is inverse proportional to the diameter of the scanning sample. In order to obtain higher resolution, a smaller sample diameter is required. As the aim of the experiment is to visualize multiphase fluid distribution at the pore scale, higher image resolution is required and, thus, smaller sample dimensions are necessary. Customized cores were drilled for the set of experiments. This section describes rock properties and the coring procedure.

3.2.1 Rock Properties and Coring

Berea sandstone was chosen as a porous media of interest. Bulk absolute permeability for the rock was 200 millidarcy (mD) and bulk porosity of 0.2. The sample was initially water wet. Original Berea core sample was about 40cm in diameter and 20 cm long. In order to achieve image resolution of a few microns it was decided to use 2 mm cores in diameter. 2 mm diameter cores here and later will be referred to as tomo-cores. The large core sample was drilled using 3/16” diamond coated drills manufactured by Lasco Diamond Products. The tomo-cores were manually cored using a drill press along with diamond drill bits in the geology department of Louisiana State University. As coring requires surface lubrication with water, the tomo-cores were extracted and dried before the flooding procedure. Figure 3.2.1 shows the drill press with the Berea sample and the diamond drill bit.
In order to extract solid tomo-cores the following coring procedure was followed.

1. Cut out a smaller portion of the original Berea sample.

2. Adjust the Berea sample between two plates so the sample is not movable.

3. Insert a diamond coated drill so that visible length of the drill is appropriate for the sample length.

4. Attach a water supply tube for the sample and drill lubrication during the drilling.

5. Start water supply

6. Start the drill press and manually lower the drill to the surface of the rock.

7. Start drilling through the rock at a steady and slow rate.

8. Constantly provide water supply for drill bit lubrication.

9. Repeat steps 8 and 9 for the preferred length of the core. For a 5mm sample, 6 to 10 repetitions are required.
10. Pull the drill up, stop the drill bit and extract the drilled core.

11. Place the tomo-core into an oven at minimum of 105 °C for 30 minutes to let water residue evaporate if necessary.

Proper laboratory personal protective equipment (PPE) is required such as laboratory coat, goggles, and safety gloves. Ten tomo-cores were drilled out and six cores were used in future experiments. Figure 3.2.2 shows an extracted tomo-core. Average length of the tomo-cores was around 5mm with tomo-core diameter of 2mm.

![Figure 3.2.2 Tmo-core and scaling](image)

### 3.2.2 Wettability Alteration through Sylilation

There is limited information on wettability alteration from hydrophilic to hydrophobic in intact porous media through sylilation reaction. Most of the studies were performed on either glass surfaces such as glass beads or quartz plates (Takash 1989, Almanza-Workman 2001, Paidin 2006,). Glass beads as well as quartz plates have ideal surfaces. Moreover, wettability alteration in such materials only requires surface treatment of each particular glass bead or plate as it is not cemented into an intact media. Takach (1989) attempted sylilation reaction in Berea sandstone by placing a Berea sample under vacuum. After a thorough literature review, a
modified wettability alteration procedure through a sylilation reaction was suggested. The procedure is based on Paidin’s and Takach’s work. A step by step description is provided below. The procedure can be altered depending on the available equipment and materials used. Six tomo-core were prepared for core floods. It was suggested to keep two out of six tomo-cores in water wet state. Four out of six tomo-cores were treated using dimethyldichlorosilane. The following procedure was used.

1. Rinse tomo-cores with sample solvent – CH₂Cl₂ – to remove possible residue and contamination.
2. Dry tomo-cores at a room temperature for 10 minutes.
3. Prepare treatment solution as 5% Si(CH₃)₂Cl₂ in CH₂Cl₂.
4. Place tomo-cores into the solution and cover them with a laboratory stretch tape.
5. Place solution with tomo-cores into a vacuum chamber and close it.
6. Start vacuum and treat tomo-cores under vacuum for 10 minutes. As the cores are treated under the vacuum, the air is removed from the pore structure letting the treatment solution imbibe into the medium.
7. Rinse tomo-cores with CH₂Cl₂.
8. Soak tomo-cores in CH₃OH for 10 minutes for deactivation.
9. Remove tomo-cores from CH₃OH and air dry them.
10. Place tomo-cores in 120 °C-180 °C oven to speed covalent bond formation between coating layer and inorganic rock surface if necessary.

The above steps were performed in fume hood using PPE. Dimethyldichlorosilane is a highly reactive compound with volatile by products such as HCl (see section 3.1.3 for more details). Hence, proper conditions should be created and high cautions must be practiced. Treated
cores were test for hydrophobicity. A water droplet was placed on the surface of the treated cores. The droplet did not attach to the core surface nor propagate through the core as it would in case of water wet sample. Thus, it was concluded that the sylilation treatment was successful.

3.2.3 Core Flood Cell Set-up

The tomo-core diameter was 2 mm and lengths ranged from 4mm to a maximum of 6.5mm. Therefore, it was required to create a mini Hassler cell that would be able to withhold flow through the media. An important part for the flow cell is the ability to allow x-ray through without absorbing any. Hence, only materials transparent to x-rays were considered. The final cell design was accepted after several trials and errors. It consists of tygon tubing and composite resin epoxy. Clear laboratory tygon tubing order through McMaster-Carr (25ft long and 1.58mm ID and 3.18mm in OD). Composite resin epoxy glue was ordered through McMaster-Carr as well. Epoxy glue used for the experiment was a 3M adhesive cartridge consisting of two components. The cartridge only worked through 3M manual and air-powered dispersing gun and mixer nozzles. DP100 Plus chosen for the experiment as it is a high strength glue that bonds most metal and plastic materials. It begins to harden after three minutes of exposure and reaches its highest strength after 48 hours.

The main goal of the cell was to create strong and structured fitting/bond with the core that would allow fluid to flow through the pore space, as well to be transparent to x-rays so that sample could be placed into the imaging chamber without being extracted from the flow cell. Such design would preserve phase saturations at equilibrium during x-ray scan.

Tygon tubing of smaller inner diameter than the tomo-core diameter was chosen in order to create tight tubing-core connecting. The tomo-core was placed into the tygon tubing after tubing expansion through heating. Tygon tubing was chosen over heat shrink tubing due its
flexibility and sturdiness. Tubing was fitted from both sides of the tomo-core. One side of the tubing was longer than the other one. Two tubing ends met in the middle of the tomo-core. Epoxy glue then was placed on the top of the tubing covering the space between the tubing sections and sealing two tubing together with the tomo-core. The epoxy was allowed to cure for more than 48 hours in order to reach its highest strength. After 48 hours, all cells were tested for flow and leaks by flowing air through into a water bath. The detailed step-by-step core flood cell build-up procedure is listed below.

1. Cut two pieces of tygon tubing: 2 feet and 0.3 feet respectively.
2. Heat expand one side of each tubing.
3. Place one side of the tomo-core in each tube so that both tubes meet half way through the core. This needs to be done while the tubing is hot. The tubing will shrink once it cools off.
4. Let tubing cool off. Both sides of the tubing should be static on the tomo-core.
5. Adjust epoxy cartridge on the manual dispersion gun.
6. Place tubing containing tomo-core so that it does not touch any surface. You may hang the tubing.
7. Apply glue on the tubing starting with small amounts by spreading it through the connection whole and tubing surface around tomo-core containing area.
8. Let the first layer of glue dry.
9. Apply several more layers of glue while rotating sample for homogenous glue application.
10. Wait 10 minutes before placing the cell into a flat surface.
11. Epoxy glue will achieve highest strength after 48 hours; therefore, do no perform any
experiments on the cell until after this time.

The above steps were performed in the laboratory setting using appropriate PPE and
equipment. Figure 3.2.3 shows core flood cell set-up at initial stage and after 48 hours of curing.

![Figure 3.2.3 Tomo-core and the flow cell before and after curing](image)

3.2.3.1 Test for flow connectivity and leaks

The flow tubes were allowed to cure for 48 hours. Before saturation experiments each flow
cell was tested for connectivity, flow through, and leaks. Figure 3.2.4 (a) and (b) shows the
testing procedure. Initially one side of the flow line was placed into a water bath and air was
injected from the top. As air went through, air bubbles appeared in the water bath, which
indicated connection between the two flow lines. The flow line was reversed and the other end of
the line containing tomo-core was placed into a water bath. Air was injected from the top. No air
bubbles were observed around tomo-core containing are as well as around glued part of the line.
Thus, it was concluded that no leak areas were present. All six tomo-core flood cells were tested
following the same procedure.
3.2.3.2 Test for channeling

Tomo-core core flood cells showed connectivity and no indication of leaks in the epoxied areas. Flow channeling through the glued area or around the tomo-core was one of the biggest concerns prior to flooding experiments. Therefore, one of the flood cells was tested for possible channeling around the tomo-core. The cell was placed vertically with an inlet flow through the two-foot side of the line. Brine was allowed to flow vertically from top to bottom by means of gravity. A 10ml syringe was attached to the inlet and filled with 10ml of brine. No external pressure was applied. The core was initially dry and 100% air saturated. The objective of this flow experiment was to estimate brine permeability at residual air saturation. If brine
permeability was higher than rock absolute permeability then extra flow channels due to bypassing were present. If brine permeability was lower than absolute permeability then no channeling was observed.

Volume change of the brine together with time was recorded. Darcy law was used to estimate brine permeability. Brine permeability was estimated to be 152 mD, which was lower than absolute permeability value of 200 mD. Therefore, it was assumed that no extra flow channels were present in the system.

3.3 CORE FLOOD PROCEDURE

A total of six samples were used: two water-wet cores and four oil-wet cores. All water-wet cores and two oil-wet cores were saturated via imbibition. The rest of oil-wet cores were saturated through drainage. Two-step core flood protocols were developed for imbibition and drainage of water and oil-wet cores respectively.

3.3.1 Imbibition – Stage 1

1. Connect a 2 ft a line a syringe and fill syringe with non-wetting fluid.
2. Connect 0.5 ft line to a vacuum pump through a two way valve.
3. Start the pump and let non-wetting fluid propagate through the line and the core.
4. Isolate lines and open valve in order to allow further flow.
5. Inject total 10 ml of non-wetting fluid.

During imbibition displacement in stage 1 cores were saturated with a non-wetting phase. In a water-wet system a non-wetting phase was Isopar E and in oil-wet system a non-wetting phase was brine.
3.3.2 **Drainage – Stage 1**

1. Connect 2 ft a line a syringe and fill syringe with wetting fluid.
2. Connect 0.5 ft line to a vacuum pump through a two way valve.
3. Start the pump and let wetting fluid propagate through the line and the core.
4. Isolate lines and open valve in order to allow further flow.
5. Inject a total of 10 ml of wetting fluid.

During drainage, cores were initially saturated with wetting phase. In the water wet systems, the wetting phase was brine and in the oil-wet systems the wetting phase was Isopar E. Figure 3.3.1 (a) and (b) shows schematics and the actual set up for stage 1 tomo-core flooding both for drainage and imbibition.

3.3.3 **Imbibition – Stage 2**

1. Reverse flow line
2. Fill syringe and a needle with a wetting fluid so that no air bubbles are present.
3. Connect syringe and needle to a 0.3 ft flow line.
4. Place needle as close to the core as possible in order to prevent air injection.
5. Set flow rate to the selected value.
7. Inject several pore volumes of the wetting fluid.
8. Check effluent for wetting fluid production.
9. Stop the pump and isolate core and flow lines.

In imbibition displacements during stage 2 cores were flooded with a wetting phase. In a water-wet system a wetting phase was brine and in oil-wet system a wetting phase was Isopar E.
3.3.4 Drainage – Stage 2

1. Reverse flow line

2. Fill syringe and a needle with a non-wetting fluid so that no air bubbles are present.

3. Connect syringe and needle to a 0.3 ft flow line.
4. Place needle as close to the core as possible in order to prevent air injection.

5. Set flow rate to the prescribed value.


7. Inject several pore volumes of a non-wetting fluid.

8. Check effluent for non-wetting fluid production.

9. Stop the pump and isolate core and flow lines.

In drainage displacement both cores were initially saturated with a wetting phase. Therefore, in stage 2 all cores were flooding with non-wetting fluids. For a water-wet system the non-wetting fluid was Isopar E and for oil-wet rocks the non-wetting phase was brine. Figure 3.3.2 (a) and (b) pictures schematics and an actual set up for stage 2 tomo-core flooding both for drainage and imbibition.

Figure 3.3.2 (a) and (b) Schematic of stage 2 of tomo-core flood procedure
Chapter 4: Imaging and Image Analysis

In order to investigate phase distribution in details, microCT, in particular cone beam microtomography, was chosen as a tool of interest. Scanning instrument was finalized based on the instrument and the facility availability. This chapter details instrument description, scanning protocol for the sample imaging, image reconstruction and image processing techniques.

4.1 INSTRUMENT DESCRIPTION

Imaging was performed at the High Resolution X-ray Computed Tomography Facility at the University of Texas at Austin using Xradia microCT. Xradia microCT is a scanner that operates at five different magnifications such as 0.5X, 4X, 10X, 20X and 40X. Because of its detector magnification capability Xradia can also be classified as an x-ray microscope. Xradia is a cone beam instrument; therefore, entire volume can be acquired at a single rotation. Xradia operates at Hamamatsu x-ray source that is capable of energy ranges from 40 Kv to 150 Kv. Due to the magnification range from 0.5X to 40X the spatial resolution of Xradia ranges from 30μm to 0.5μm. However, the resolution is constrained by the sample thickness and overall sample dimensions. The higher the sample resolution, the lower the sample dimensions are required. Hence, it is critical to plan sample size and spatial resolution of interest beforehand.

4.2 DATA ACQUISITION

Prior to the scan each sample is shaped and mounted. Xradia operates at a constant energy length throughout the entire scan. Therefore, it is important to thoroughly choose the right scanning energy. This section gives a detailed description of the sample mounting and instrument calibration, imaging and result collection.
4.2.1 Sample Mounting and Calibration

MicroCT imaging field is a cylinder that is constructed through the stack of circular fields of views. The sample is typically rotated at a constant degree increment. Thus, it is important to make sure that the sample mounted in the right field of view for the given energy and the resolution. As data is collected at increments and later on stitched together, it is critical to ensure that the sample is immoveable during the scan. Summary of the steps taken prior to microCT imaging is outlined below:

1. Shape the core sample as required by the instrument and the view field.
2. Cover the sample with a thin layer of parafilm to avoid fluid movement/loss.
3. Tightly mount the sample on the stage.
4. Check sample alignment for proper positioning.
5. Choose optic type, degree of binning and scanning energy level based on the resolution. It is recommended to stay above photoelectric edge of the tracer in order to enhance phase separation.
6. Finalize the scanning parameters and begin image collection.

All the samples in this study were scanned using the same scanning protocol to ensure consistency. The scan parameters were the following:

1. Scanner type – Xradia Microscanner.
2. Zooming parameters – 4X objectives.
3. Acquisition time – 8 seconds.
4. Voxel resolution – 4 micron.
5. Scan settings – 50 kV, 10 W with detector at 25 mm and source at -37 mm.
7. Total number of views is 2161.

8. No filter, dithering or sample drift applied.

9. End reference – 90 frames (each 3.5 seconds).

Final scanning protocol was chosen based on the preliminary scanning of a dry and unsaturated Berea sandstone sample. Figures 4.2.1 and 4.2.2 show Xradia microscanner used in these experiments.

Figure 4.2.1 Xradia microCT outside set-up (Biomedical Imaging Division 2014)

Figure 4.2.2 Xradia micro CT inside set-up (Biomedical Imaging Division 2014)
4.2.2 Data Collection and Reconstruction

The images were collected at a constant angle increment of 0.25° with a total number of 2161 view and 90 frames at 3.5 seconds each. The collected raw data was represented in terms of lines that contained detector reading for each view, where time progressed from the top to the bottom. Such raw data images are called sinograms, where every point of the scanned sample corresponds to a sinusoidal curve. Once the scanning is complete the sinusoidal images are reconstructed. Reconstruction transforms sinusoidal data to either raw data or tiff data.

Sinograms were reconstructed following the same procedure. Reconstruction was performed using Xradia reconstructor available at University of Texas at Austin. Data was reconstructed with center shift 2, beam hardening 0, theta 0, byte scaling [0, 4000], binning 1, recon filter smooth (kernel size = 0.7). Total number of final slices obtained was 929. Each slice was represented by 16 bit tiff image with 4 micron resolution.

During image reconstruction raw material intensities were converted to CT values that on a 16 bit image ranged from 0 to 65536. Each system component such as various rock grains, water or oil received its CT value. CT values assigned were dependent on the instrument type and calibration. As an example, at the University of Texas, Xradia based scans air was assigned CT values of 3000 and below. The University of Texas CT lab ensures that no data is generated below and above the lowest and the highest CT values so no dimensional data is lost during the imaging and reconstruction. Example of sinogram is given in Figure 4.2.3.
4.3 IMAGE PROCESSING

Image processing is one of the most important parts of the microCT image analysis. It is essential to ensure proper phase and element identification. The study was based on qualitative analysis of multi-phase distribution in an intact core; therefore, it was critical to properly identify phase separation between water and oil within the porous medium. This section will lead through the steps and procedures used to perform phase segmentation, phase distribution identification, residual phase saturations and porosity estimation.

4.3.1 Image Scaling

The data after microCT scan was complete was delivered in terms of 16 bit tiff image sequence that formed a volume file. 16 bit images contained CT values ranging from 0 to 65536, where each CT value corresponded to a phase element. Typically phase elements have a range of CT values in several thousands and in certain cases just several hundreds. Hence, it is suggested
to rescale 16 bit images for the range of interest in order to maximize contrast among phase elements.

Initially data was collected in terms of sinograms, which after reconstruction were converted into 16 bit tiff sequence images (refer to section 4.2.2). Figure 4.3.1 shows an example of a 16 bit reconstructed image.

![Reconstructed 16 bit grey scale image obtained using cone beam microCT](image)

**Figure 4.3.1** Reconstructed 16 bit grey scale image obtained using cone beam microCT

### 4.3.1.1 Volume of interest

Reconstructed image contained full range of data including the empty space surrounding mounting stage. Therefore, it was essential to eliminate these data by subtracting an elementary volume of interest. The chosen volume dimensions were arbitrary chosen based on original data size, resolution and image quality. In order to have consistency in data analysis it was decided to have the same volume of interest dimensions for all the samples.

Volume of interest extraction was performed using public domain Java image processing program, ImageJ. Generalized procedure on elementary volume extraction is detailed below.

1. Upload image sequence into Image J as following: File → Import → Image Sequence.
2. In a newly opened window navigate to the folder containing tiff images, double click on the first image and sequence settings window will appear. Change settings if necessary and click OK.

3. A window with sample in XY view will appear.

4. Choose Rectangular Selection on the top left hand corner of the ImageJ panel.

5. Navigate on the image and select the area of interest (Figure 4.3.2).


7. In a newly opened window specify dimensions of interest.

8. Once selection with dimensions of interest is chosen click on Image → Crop or press Ctrl+Shift+X simultaneously.


10. Reslice newly created image as following: Image → Stacks → Reslice.

11. A new view window with XZ sample view will appear.

12. Check for image homogeneity and/or crop unwanted objects if necessary.

13. Make sure that no external data is present on the final image.

14. Reslice XZ view back to XY view and save newly created image: File → Save As → Raw Data. Raw data files were preferred in this work. However, images can be saved in various formats based on work flow and user’s preference. Final result is shown in Figure 4.3.3.
Figure 4.3.2 Selection of cropping area

Figure 4.3.3 Cropped volume of interest
4.3.1.2 Rescaling

16 bit volume of interest raw file still contains a large range of data, which can be observed on the histogram provided in Figure 4.3.4.

![Histogram for a 16 bit volume of interest](image)

Figure 4.3.4 Histogram for a 16 bit volume of interest

For the given example CT values range from 3502 to 65535. Given that air CT values were 3000 and below, it was concluded that no air was present. Moreover, since example image provided in Figure 4.3.3 contains a wide range of data, the image appears to be dark. Adjusting image brightness setting will result in brighter and clearer image. It is recommended to adjust brightness so it contains both data peaks within its range. Minimum value can be set close to the first peak and maximum value can be set close to the second peak, which will result in a better data visibility. In such case all the data to the right side from the highest brightness range or all the data to the left side from the lowest brightness setting will be merged together. Such data adjustment is called image rescaling. Example of brightness adjustment using ImageJ is provided below.

1. Upload file of interest into ImageJ as following: File → Import → Raw Data.
2. In a newly opened window adjust image type, width, height and number of images to
the given image settings and requirements and press ok.

3. Go to Image → Adjust → Brightness/Contrast or press Ctrl+Shift+C simultaneously.

4. Set the minimum and maximum brightness values to the values of interest so that
both data peaks are within the brightness range and press apply (Figure 4.3.5).

![Figure 4.3.5 Brightness adjustment example](image_url)

The image is now rescaled. However, in order to complete the process and have the
applied brightness settings saved for further analysis, the image needs to be converted into 8 bit
image type. 8 bit image type contains form 0 to $2^8$ data or 256 CT values. To convert image from
16 bit to 8 bt using ImageJ use the steps provided below:

1. Import image of interest (typically 16 bit image type).

2. Adjust brightness/contrast on the uploaded image as described above.

3. Go to Image → Type → 8 bit.
4. Save image as Raw data. Note: New file now is in 8 bit image format with data range from 0 to 256 (Figure 4.3.6).

![Figure 4.3.6 8 bit rescaled REV image](image)

**4.3.2 Image Filtering**

Image filtering is used to remove “noise” by smoothing the high frequency data. “Noise” is a random disturbance of the data. In order to perform proper image segmentation such random high frequency data should be smoothed. Image filtering tools helped remove such noise without altering the data.

Anisotropic diffusion module in Avizo 7.1 was used to filter high frequency data. Anisotropic diffusion is a nonlinear diffusing method, where diffusion is perpendicular to the edge, which allows removing the “noise” and smoothing high frequency data by not blurring and preserving edges. 8 bit rescaled image was used in anisotropic diffusion. Data was uploaded into Avizo 7.1 and anisotropic diffusion image filter was applied. Number of iteration for smoothing was pre-set to five and kept the same for all the samples. Contrast threshold for the edge preservation was chosen based on trial and error. Several anisotropic diffusion filters at various threshold values were applied to the same data. The results were qualitatively compared and the
best image was chosen. Summary of the steps on how to apply anisotropic diffusion in Avizo 7.1 is listed below:

1. Upload image into Avizo 7.1 following the instructions.
2. Right-click on the image title.
3. From the dropdown list choose: Image filtering → Anisotropic diffusion.
4. Adjust threshold value if necessary and click apply.
5. The resulting image will be generated under the original image.
6. Right-click on a resulting image and save it as Raw 3D data file.

Anisotropic diffusion on a porous material such as sandstones, sand packs, glass bead columns or carbonates results in smoothed grains and well defined grain edges. Moreover, the data peaks on the histogram become narrower and sharper compared to unfiltered data. Example of a filtered image is given in Figure 4.3.7. In order to qualitatively assess the effect of image filtering on image quality before and after images are put side by side (Figure 4.3.8).

![Filtered image example with histogram](image)

Figure 4.3.7 Filtered image example with histogram
4.3.3 Image Segmentation

In order to identify phase distribution and estimate such morphological properties of the porous medium as porosity, phase saturations, tortuosity or pore network structure, image segmentation must be performed. Image segmentation is a binarization of the grey scale based image. Image segmentation is based on identifying data populations based on the CT values. Two different segmentation methods were used in this work. Indicator kriging was used for segmenting between void phase and the grains, and watershed segmentation was used to segment between oil and brine. Three phase segmentation was obtained through image summation using image calculator tool in ImageJ.

4.3.3.1 Indicator kriging

Indicator kriging uses local thresholding criterion based on two threshold values: the lower threshold value and the upper threshold value. Threshold values are chosen based on the image histogram. For the example given in Figure 4.3.7, lower threshold value was chosen so that the small data peak is to the left of it and the upper threshold value was chosen so that the...
large data peak is to the right of it. In such scenario all the data to the left of the lower threshold value and all the data to the right of the upper threshold value would be grouped together respectively. The values in between two threshold values were assigned to either one of the populations based on the maximum likelihood estimate of each population using two point correlation function (Oh and Lindquist, 1990). However, the choice of threshold values was based on the qualitative analysis of the image and trial and error image thresholding using ImageJ. The difference between the lower and the upper thresholds can be of a different magnitude depending on the image quality. Example of a segmented image for void versus grain using indicator kriging is given in Figures 4.3.9 (a) and (b). Binary image contains values on the range from 0 to 1, where grains are identified as 1 and void space is specified as 0.

Figure 4.3.9 (a) Threshold values identification for indicator kriging; (b) indicator kriging segmented image

Indicator kriging segmentation was performed using Louisiana State University developed code. The program was run through LSU high performance computing center (HPC). Detailed description on how to use HPC clusters is available on HPC official page at hpc.lsu.edu.

In order to run indicator kriging three program files should be put together in one working folder:
script file, input file (ik.in) and executable indicator kriging file (ik3p). Input file, ik.in, allows to
specify file location, file name, output file type and output file name as well as threshold values
chosen for the indicator kriging.

4.3.3.2 Watershed based segmentation

Watershed is a gradient segmentation, which is based on the approach introduced by
Sheppard et al. (2004). The concept is centered on identifying known regions of the image using
simple thresholding. The uncertainty regions, such as transition between two liquid phases, are
identified using image intensity gradient. Thus, the transition between two phases would be
specified at the phase inflection point. Therefore, it is recommended to use watershed
segmentation method in order to properly identify liquid-liquid or liquid-vapor phase transitions.
Simple thresholding and indicator kriging type of segmentation methods are not effective in
identifying liquid transition regions.

Watershed segmentation program was used to identify aqueous versus oil phases. The
approach was available as one of the segmentation modules in Avizo 7.1. Avizo watershed
segmentation module did not require any qualitative analysis as the module calculated image
gradients and identified threshold boundaries automatically. However, users were able to specify
threshold limits: upper and lower thresholding for various phases if desired. Step by step
watershed segmentation procedure is listed below.

1. Upload image file into Aizo 7.1 – follow the instruction by choosing the right settings
   for file type and file formatting.
2. Right click on the image title and attach orthoslice module to it.
3. Right click on the image title and choose Image segmentation → Watershed
   segmentation.
4. Follow the instruction for watershed based segmentation and click apply once all the settings are in place. More information on watershed segmentation and detailed procedure description can be found in Avizo documentation or help module.

At the end of the segmentation Avizo created several image files. If the user specified to segment for two phases, Avizo would create three separate image files: image file for phase 0, image file for phase 1 and combined image file.

Indicator kriging was used for the void space versus grains segmentation; therefore, the number of phases specified in watershed segmentation was equal to two: oil vs. the rest of the core. This was based on the fact that only aqueous phase contained a CT tracer. Thus, aqueous phase had higher CT values compared to the oil phase and was brighter than the oil phase on the image. Thresholding for oil phase was done based on Avizo calculated gradient mask. Nevertheless, oil threshold value was within initially identified CT values. Phase CT values were determined based on the phase meniscus detection on the original 16 bit image sequence file (Figure 4.3.10). As oil phase was the only phase of interest, the only work file of interest was output file for phase 0, which represented segmented oil phase.

Watershed segmentation was performed on the same image set twice. Initially cropped 16 bit image files were rescaled for aqueous and oil phases, where aqueous phase was noted in grey color, oil phase - dark grey color and the rest of the core matrix was white. This was achieved by setting lower brightness limit to a minimum oil CT value of 5,000 and the upper brightness limit to a maximum aqueous phase CT value of 10,000. Such image files here and further would be referred to as a phase-rescaled image files. An example of the phase-rescaled image file is shown in Figure 4.3.11. Another run of watershed segmentation was performed on the originally rescaled grey-scale image used in void space versus grain indicator kriging segmentation. Both
image files were converted to 8 bit image types prior to segmentation. Each phase’s threshold values were estimated on 8 bit image files by comparing 16 bit versus 8 bit image types for each phase separately. Phase-rescaled image required image filtering for noise removal; therefore, anisotropic diffusion was applied to all the images using the same procedure as described in section 4.3.2. Both image files showed similar estimates of residual oil saturation with a relative error of a few percent. It was decided to use grey scale images for future analysis. An example of watershed segmentation is given in Figure 4.3.12.

4.3.3.3 Three phase segmentation.

Three phase segmentation was achieved by image summation using ImageJ image calculator. Indicator kriging segmentation resulted in a binary image file with the range of values from 0 to 1, where void space was 0 and solid matrix was 1. Watershed segmentation resulted in a binary image with the oil having value of 0 and the rest of the core matrix having value of 1. Hence, after image summation oil was denoted to as 0, aqueous phase was denoted to as 1 and grain phase was denoted to as 2, with color notation as following: black for oil phase, grey for aqueous phase and white for grain phase. Example of three phase segmented image is given in Figure 4.3.13.

Figure 4.3.10 Original 16 bit image file with phase assigned CT values
Figure 4.3.11 Phase rescaled image example

Figure 4.3.12 Watershed segmented image example
Figure 4.3.13 Three phases segmented image example
Chapter 5: Discussion of the Results and Conclusions

In this chapter, the project results and conclusions will be discussed. The results are presented in terms of the core porosity, residual saturations and fluid phase distribution and morphology.

5.1 POROSITY ESTIMATE

Matrix porosity was estimated using the microCT segmented images based on the pixel count. Four separate sets of data were segmented for porosity: dry image sample, water wet imbibition sample and oil-wet drainage and imbibition samples. Image sets, sample notation used in this work and sample description are summarized in Table 5.1.1.

<table>
<thead>
<tr>
<th>Sample Full Name</th>
<th>Sample Notation</th>
<th>Primary Fluid</th>
<th>Secondary Fluid</th>
<th>Displacement Mechanism</th>
<th>Expected oil saturation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry sample</td>
<td>Dry</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>None</td>
</tr>
<tr>
<td>Water-wet-imbibition</td>
<td>WWO</td>
<td>Oil</td>
<td>Brine</td>
<td>Imbibition</td>
<td>Residual oil, S_{or}</td>
</tr>
<tr>
<td>Oil-wet-drainage</td>
<td>OWO</td>
<td>Oil</td>
<td>Brine</td>
<td>Drainage</td>
<td>Residual oil, S_{or}</td>
</tr>
<tr>
<td>Oil-wet-imbibition</td>
<td>OWW</td>
<td>Brine</td>
<td>Oil</td>
<td>Imbibition</td>
<td>Oil, S_{o}(1-S_{wr})</td>
</tr>
</tbody>
</table>

Churcher et al. (1991) reported average porosity range for Berea sandstone from 19.6% to 26%. Average grains size detected in several Berea sandstone sample ranged from 50 \(\mu m\) to 180 \(\mu m\) with an average pore body size of 70 \(\mu m\) to 114 \(\mu m\). Largest pore body size reported was 300 \(\mu m\) detected in Orange Berea.
Dry sample was scanned as a preliminary test sample at the University of Texas CT (UTCT) laboratory. Scanning protocol for the dry sample was different from the final scanning protocol used for the saturated samples. Dry Berea sample core was scanned at 5 micron resolution and 90 keV. In comparison final scanning protocol was set at 4 micron resolution with the energy level of 50 keV.

Given the resolution of 5 μm and 4 μm respectively, as the rule of thumb established at the UTCT facility, the smallest detectable feature is equal to resolution times 4. Hence, the smallest detectable feature on a dry sample was about 20 μm and the smallest detectable feature on water-wet and oil-wet samples was 16 μm. Based on Churcher (1991) most morphological features of the Berea sandstone should be detectable at the given resolution.

Berea sandstone core sample used in this work was reported to have porosity of 20% and permeability of 200 mD. Indicator kriging segmentation was run on all four image sets. Each image set showed porosity estimate close to the reported value with +/-3% deviation. Porosity calculations were based on segmentation results, and, thus are susceptible to human error as the threshold values used in the indicator kriging segmentation were chosen qualitatively by the user. Porosity estimates are summarized in Table 5.1.2.

<table>
<thead>
<tr>
<th>Sample Name</th>
<th>φ, %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dry</td>
<td>17</td>
</tr>
<tr>
<td>WWO</td>
<td>17</td>
</tr>
<tr>
<td>OWO</td>
<td>18.4</td>
</tr>
<tr>
<td>OWW</td>
<td>19.5</td>
</tr>
</tbody>
</table>
Figures 5.1.1 through 5.1.4 show segmented slice examples for dry, water-wet imbibition (WWO), oil-wet drainage (OWO), and oil-wet imbibition respectively (OWW).

Figure 5.1.1 Dry sample segmented for void space

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (void)</td>
<td>2,947,061</td>
</tr>
<tr>
<td>1 (rock)</td>
<td>17,253,439</td>
</tr>
<tr>
<td>$\phi, %$</td>
<td>17</td>
</tr>
</tbody>
</table>

Figure 5.1.2 WWO segmented for void space

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0 (void)</td>
<td>2,890,245</td>
</tr>
<tr>
<td>1 (rock)</td>
<td>17,310,255</td>
</tr>
<tr>
<td>$\phi, %$</td>
<td>17</td>
</tr>
</tbody>
</table>
Figure 5.1.3 OWO segmented for void space

| 0 (void) | 3,107,000 |
| 1 (rock) | 17,093,500 |
| $\phi, \%$ | 18 |

1.340mm

Figure 5.1.4 OWW segmented for void space

| 0 (void) | 3,146,403 |
| 1 (rock) | 17,054,097 |
| $\phi, \%$ | 18.4 |

1.340mm
5.2 PHASE SATURATIONS ESTIMATES

Six cores were saturated and prepared for imaging. Four out six cores had undergone wettability alteration prior to core floods. Total of two water-wet samples, and four oil-wet samples were saturated and three out of six samples were imaged using microCT. The three samples included water-wet-imbibition, where dry and vacuumed core was initially saturated with oil; oil-wet-drainage, where core was initially saturated with brine; and the final scanned sample was oil-wet-imbibition, where core was initially saturated with oil. Three cores were at different wettability states and displacement mechanisms. Hence, final oil saturations were expected to vary. Water-wet Berea sandstone was reported to have residual oil saturation to water flood of 30%-35%. Typically, macro scale core floods are performed in 1 foot per day flow rate, which corresponds to the average flow rate used in the field waterflood operations. As this analysis mainly was focused on oil vs. water phase distribution, injection flow rates were chosen based on the flow sell settings and the time required to saturate the core.

5.2.1 Capillary Number Analysis

One of the widely used estimates for fluid phase saturations is capillary number vs. saturation curves also called capillary desaturation curves (CDC). Capillary number is a dimensionless group that represents competition of viscous versus capillary forces. CDC curves for both water-wet and oil-wet rocks are widely reported and the literature and generated based on the simulation and laboratory data.

Capillary numbers were calculated for the three core floods used in this analysis. Equation (2.9) for capillary number is given in section 2.1.3 of chapter 2. Capillary number equation includes such data as fluid viscosities, interfacial tension for oil and fluid velocity. Oil
viscosity and interfacial tension values were obtained through product’s material safety data sheet. Brine physical properties were assumed to be identical to the properties of fresh water. Fluids’ physical properties and core dimensions are summarized in Table 5.2.1.

Table 5.2.1 Fluid physical data and core dimensions

<table>
<thead>
<tr>
<th>r(cm)</th>
<th>0.09</th>
</tr>
</thead>
<tbody>
<tr>
<td>h(cm)</td>
<td>0.5</td>
</tr>
<tr>
<td>A (cm²)</td>
<td>0.2827</td>
</tr>
<tr>
<td>σ oil (N/m)</td>
<td>0.0210</td>
</tr>
<tr>
<td>σ brine (N/m)</td>
<td>0.0720</td>
</tr>
</tbody>
</table>

All cores were initially saturated using gravity driven flow as described in sections 3.3.1 and 3.3.2 of chapter 3. However, secondary flood was performed using syringe pump (refer to sections 3.3.3 and 3.3.4 of chapter 3). Flow rate in secondary flood initially was equal to 50 ml/min and steadily increased to 100 ml/min or 150 ml/min throughout the flow. Capillary number estimations for the range of flow rates between 50 ml/min and 200 ml/min for water-wet-imbibition and oil-wet-drainage floods are reported in Table 5.2.2.

Table 5.2.2 N_c calculations for WWO and OWO

<table>
<thead>
<tr>
<th>Flow rate (ml/min)</th>
<th>N_c</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>9E-04</td>
</tr>
<tr>
<td>200</td>
<td>3E-03</td>
</tr>
</tbody>
</table>

Capillary number estimates for oil-wet-imbibition core are listed in Table 5.2.3.
Table 5.2.3 $N_c$ calculations for OWW

<table>
<thead>
<tr>
<th>Flow rate (ml/min)</th>
<th>$N_c$</th>
</tr>
</thead>
<tbody>
<tr>
<td>50</td>
<td>4E-04</td>
</tr>
<tr>
<td>200</td>
<td>2E-03</td>
</tr>
</tbody>
</table>

For the given set of cores and flow mechanisms, capillary number values of water-wet-imbibition and oil-wet-drainage cores ranged from 0.0009 to 0.003. For oil-wet-imbibition cores, capillary number at specified conditions ranged from 0.0004 to 0.002.

Capillary desaturation curves generated by Camilleri (1983) were used for the saturation estimates. In the capillary desaturation curves analysis, water-wet-imbibition and oil-wet-imbibition cores were used to estimate the non-wetting residual phase saturation to either waterflood or oil flood. Oil-wet-drainage residual oil saturation to waterflood estimate was based on non-wetting phase capillary desaturation curves. Residual brine saturation to oil flood ($S_{wr}$) was estimated for oil-wet-imbibition core. Thus, oil saturation was calculated as $1 - S_{wr}$. Figure 5.2.1 shows saturation range estimates for all three cores.

In Figure 5.2.1 y-axis corresponds to the normalized residual saturation, where residual saturation is normalized against the the plato value, which for the given graph is equal to 1. Residual and oil saturation ranges for the cores with corresponding flow rates are listed in Table 5.2.4.
Table 5.2.4 Capillary desaturation based oil saturation estimates

<table>
<thead>
<tr>
<th>Sample Full Name</th>
<th>Sample Name</th>
<th>Expected oil saturation</th>
<th>Oil saturation range, %</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water-wet-imbibition</td>
<td>WWO</td>
<td>Residual oil, S&lt;sub&gt;or&lt;/sub&gt;</td>
<td>~ 8 - 40</td>
</tr>
<tr>
<td>Oil-wet-drainage</td>
<td>OWO</td>
<td>Residual oil, S&lt;sub&gt;or&lt;/sub&gt;</td>
<td>~ 33 - 67</td>
</tr>
<tr>
<td>Oil-wet-imbibition</td>
<td>OWW</td>
<td>Oil, S&lt;sub&gt;o&lt;/sub&gt;(1-S&lt;sub&gt;wr&lt;/sub&gt;)</td>
<td>~ 47-80</td>
</tr>
</tbody>
</table>

5.2.2 Residual Oil Saturation Estimate from CT Images

Oil saturation from x-ray CT images was estimated based on the oil phase pixel count on three phase segmented images. REV was extracted from the original images, rescaled, filtered and segmented for void space using indicator kriging and oil phase using watershed approach. Two images were then summed into one file using ImageJ. Chapter 4 gives detailed description...
on the procedures used to obtain oil saturations. Oil saturations for all three cores are summarized in Table 5.2.5.

Table 5.2.5 Segmentation based $S_{or}$ estimates

<table>
<thead>
<tr>
<th>Sample Full Name</th>
<th>Sample Name</th>
<th>Expected oil saturation</th>
<th>Oil saturation, % (range %)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Water-wet-imbibition</td>
<td>WWO</td>
<td>Residual oil, $S_{or}$</td>
<td>13.5 (8-40)</td>
</tr>
<tr>
<td>Oil-wet-drainage</td>
<td>OWO</td>
<td>Residual oil, $S_{or}$</td>
<td>21 (33-67)</td>
</tr>
<tr>
<td>Oil-wet-imbibition</td>
<td>OWW</td>
<td>Oil, $S_o (1-S_{wr})$</td>
<td>65 (47-80)</td>
</tr>
</tbody>
</table>

Water-wet-imbibition core saturated with oil followed by brine showed residual oil saturation to water flood of 13.5%. Residual oil saturation in this case is lower than the observed average value in the Berea sandstone. However, the value is within the range estimated using capillary desaturation curves for the given system. Oil-wet-drainage cores initially saturated with oil followed by brine showed residual oil saturation to waterflood of 21%. Calculated oil saturation in oil-wet-drainage is out of the saturation range estimated using CDC curves. However, it is higher than the number calculated for water-wet – imbibition core. Qualitative observation of phase distribution in the oil-wet-drainage core suggested that not all of the rock surface was successfully treated during the sylilation reaction. It was concluded that oil-wet -drainage curve is in intermediate wettability state rather than in oil-wet state as some pores show water-wet characteristics and some show oil-wet characteristics. As oil-wet-drainage core is more likely to behave as an intermediate wet core; estimated residual saturation would be expected to be higher than in the water-wet core but lower than in the oil-wet core. 21% oil saturation lies in exact range between two minimum possible saturations: 8% to 33% oil saturation. For more details on the matter refer to section 5.3 of this chapter.
Oil-wet-imbibition core was initially saturated with brine followed by oil, which is comparable to the oil flood process. Oil-wet-imbibition core was treated for wettability alteration through silylation. Hence, rock surface was in favor of the oil rather than brine. Oil saturation range predicted from the capillary desaturation curves was between 47% and 80%. $S_o$ obtained from CT images was equal to 65%, which was within the range values.

5.3 PHASE DISTRIBUTION

Phase distribution was qualitatively analyzed on the segmented three phase image files. Fluid distribution was analyzed in each one separately with relation to displacement mechanisms used to create two-phase saturation and the rock’s wettability state.

Originally, all Berea cores were in water-wet state. Therefore, grain surface was hydrophilic and in preference of the water phase rather than the oil phase. In such case, during the fluid equilibrium water is more likely to spread as a film on the rock surface and occupy small pores. Residual phase distribution is somewhat different from equilibrated state. According to Lake (1984) residual wetting phase under high pressures or non-wetting phase injections causes wetting phase to retreat into concave contacts between the rock surface and other gaps within the pore space. At very high pressure wetting phase will approach a monolayer coverage on the rock surfaces and, thus, very low saturations. Residual non-wetting phase, on the other hand is more likely to be trapped in large pores. As non-wetting phase is expelled by the rock surface, theoretically, it can reach saturations close to “0” at high pressures. However, it has never been observed in simple oil-water or water-oil floods. In reality, the non-wetting phase creates ganglia of several pore diameters in length, and is more likely to have spherical or cylindrical geometry rather than simple sheet-like geometry observed in residual wetting phase.
(Lake 1984, Chatzis et al. 1983). Below is an example of large oil ganglia observed in Berea sandstone by Chatzis et al. (1983) (Figure 5.3.1).

![Figure 5.3.1 Residual oil blob observed in Berea sandstone (Chatzis 1983)](image)

**5.3.1 Water-wet -imbibition**

Water-wet – imbibition cores showed residual oil saturations of 13.5%, which was on the lower side of the estimated range. IsoparE had a lower viscosity and density than water, therefore, at high flow rates oil was displaced at a stable piston like front. Thus, low non-wetting phase saturation is more likely to be expected with oil mostly trapped in the small pores. Figure 5.3.2 gives three phase orthoviews for water-wet-imbibition core.

In the water-wet core oil was spread out throughout the core sample in small quantities. Not all the oil ganglias were connected to one another. This was due to the fact that oil had lower viscosity that water phase. The oil blubs were mostly found in the center of the large pores, within small pores or trapped in highly curved pore geometries. Representative oil ganglia was successfully isolated and its geometry was compared to the one obtained by Chatzis (1983). Visual comparison showed that the segmented oil phase blob geometry was identical to the ones reported in the literature (Figure 5.3.3).
5.3.2 Oil-wet-drainage

Oil-wet-drainage sample did not show behavior of the typical oil-wet core. The residual oil saturation was lower than expected in such conditions. After a visual analysis of the phase distributions, oil-rock and oil-brine contact; it was concluded that wettability was not altered uniformly throughout the rock. This could be due to several reasons: (1) wettability alteration agent did not spread homogeneously through the porous medium; (2) covalent bonding between the rock surface and hydrophobic coating was destroyed after continuous water injection during
the waterflood. Figure 5.3.4 shows orthoviews in XY, YZ and XZ planes. Oil blobs observed in the sample varied in its geometry and location. Some were several pore radiiuses in length located in the middle of large pores and some seem to be favoring rock surface. It was hard to visualize sheet-like geometry of the residual wetting fluid under the given resolution of 4 μm. Higher resolution is required to observe thin layers of wetting film on the grain surface.

5.3.3 Oil-wet-imbibition

Oil-wet-imbibition core showed oil saturation of 65%, which was within the predicted range. Oil was evenly distributed through the porous medium. It mostly occupied larger pores. Accounting for the wettability state of the rock, high mobility ratio and, hence, unstable displacement, such fluid phase distribution was expected. Water was more likely to be expelled from the large pores than the small pores as it was the least resistant path for the oil flow. Thus, small pores were more likely to be saturated with water rather than the oil phase. Moreover, the residual water phase was connected throughout the pore space. Orthoviews for oil-wet-imbibition sample are shown in (Figure 5.3.5).
Figure 5.3.5 Three-phase segmented OWW orthoviews
Chapter 6: Recommendations

This work was focused on designing core flood procedures for the tomography cores of a few millimeters in diameter and several millimeters in length as well as testing core flood results using microCT for the phase identification. Improvements to the sample design and recommendation for future work are listed in this chapter.

6.1 CORE FLOOD PROCEDURE

The discussed core-flood set up was designed based on the system requirements. Several designs were tried prior to the finalized one. It was noted based on the experiments that if using tygon or any other type of tubing it is important to tightly seal the core within the cell. Otherwise, extra channels are created around the core area which creates difficulty during core saturation. Recommendations for future core flood design cell are summarized below:

1. Try several other tubing types for proper sealing.
2. Use syringe pump in both flood stages. Water should be injected from one side of the core and oil should be injected from the other side of the core. Injection direction should be vertical in both cases from the top to the bottom in order to prevent possible fluid separation due to gravity segregation.
3. Try epoxy composition that hardens in a few hours or a few days. In such case it is possible to achieve homogenous glue coverage as well as strong cell bonding.
4. Insert core in heat shrink tubing prior to the epoxy application to the outer cell, which can help create steady system and strong bonding.
5. Inject at a constant flow rate, close to the real life field environment – 1 foot/day.
6. Weight cores and its attached set-up prior and post saturation procedures to obtain liquid pore volume estimates.

7. Properly seal the core and let fluids equilibrate for a few hours before imaging.

6.2 WETTABILITY ALTERATION

Wettability alteration was done using dimethydichlorosilane. Limited work is available on the application of silanes in the intact cores. Most of the experiments were either performed in glass beads, quartz plates or other inorganic materials. It is hard to achieve homogenous propagation of silanes throughout the porous medium. It is suggested to follow implemented vacuum method described in chapter 3. Recommendations for future work with silanes in intact rocks include:

1. Saturated core with water vapor, in order to have enough water molecule on the rock surface for proper sylilation reaction and strong covalent bonding of hydrophobic coating to the rock surface.

2. Place core in the silane solution under the vacuum for 30 minutes to ensure homogenous solution propagation through the medium.

3. Place treated core into a 100+ °C oven for 30 minutes or more to ensure proper oligomer and covalent bond formation.

6.3 IMAGING

Imaging was performed using cone beam microtomography, which only allowed working at a set wave length. A number of recommendations was generated based on the image analysis and data acquisition.
1. Use higher than 5% of tracer solution to ensure enough contrast between liquid phases.
2. Use hydrocarbons of higher viscosity in order to create large hydrocarbon phase trapping unless opposite is required.

6.4 IMAGE PROCESSING

Various image processing techniques were used in this work. Image segmentation was done both using LSU available tools and Avizo commercial software. Based on the results, it is recommended to use indicator kriging when working with large uncertainties and high contrast phase differences. Watershed segmentation is highly recommended in the identification of fluid interfacial tension regions. If enough phase contrast achieved among various liquid or vapor phases, indicator kriging may be used.

6.5 SATURATIONS AND PHASE IDENTIFICATION

Phase identification in this work was tricky as there was not significant contrast between phases due to several reasons: (1) instruments used in imaging did not allow scanning above and below photoelectric edge of the tracer (KI); (2) not enough tracer was used. Higher concentration of potassium iodine is required to qualitatively identify phase separation. Threshold values used in segmenting various phases were visually identified by the user and, therefore, are subject to the error. Moreover, most image processing techniques are based on the qualitative evaluation. It is recommended to use quantitative analysis in the future. It is possible to quantitatively estimate phase interfacial interfaces; however, high contrast and good quality images must be acquired.


Biomedical Imaging Division: “Xradia MicroXCT Manual: Multiscale CT Lab”, Biomedical Imaging Division, Virginia Tech Wake Forest University, School of Biomedical Engineering and Sciences, 2014.


D. Camilleri: “Micellar/polymer flooding experiments and comparison with an improved 1-D Simulator”, Master’s Thesis at The University of Texas-Austin, 1983.


G. Sharma: “Wettability Alteration in High Temperature and High Salinity Carbonate Reservoirs”, Master’s Thesis at the University of Texas — Austin. 2011.


K. Matthews: “Tomography Fundamentals”, Presentation at the Medical Physics and Health Physics Program at the Department of Physics and Astronomy at Louisiana State University. 2014.


S. Chandrasekhar: “Wettability alteration with brine composition in high temperature carbonate reservoirs”, Master’s Thesis at the University of Texas – Austin. 2013.


Vita

Dinara Dussenova was born and raised in Uralsk, Kazakhstan. Dinara graduated from a multilingual English school as well as music school with a major in Piano. She graduated with Bachelor of Science in Petroleum Engineering from the University of Texas at Austin in May 2010. After completing undergraduate studies Dinara spent a year in Italy and Germany. She enrolled in Louisiana State University in August, 2011.